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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Referto the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e (Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Spartan Arduino PLC is Open Type Controller. It is required that you install the
Spartan Arduino PLC in a housing, cabinet, or electric control room. Entry to the



housing, cabinet, or electric control room should be limited to authorized personnel.
Failure to follow these installation requirements could result in severe personal injury
and/or property damage. Always follow these requirements when Spartan Arduino
PLC.

In case of installation or maintenance of the Spartan PLC please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contrdleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.
L'automate Spartan Arduino PLC cest contrbleur de type ouvert. Il est nécessaire
d'installer I'automate Spartan Arduino PLC dans un boitier, une armoire ou une salle
de contréle électrique. L'acces au boftier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de I'installation de I'automate
Spartan Arduino PLC.

En cas d'installation ou de maintenance du Spartan PLC, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1. Spartan Arduino PLC: General Features

Supply Yaltage

24 \cce

l/Os

Digital
Analog

COMPACT SPARTAN ARDUINO PLC

Fuse protection (2.5A)

Input Voltage 12 to 24vdc Polarity protection
Input rated voltage 24 vde
Rated Power 30W
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB

I12C -- USB -- RS485 (Half

Analog Output 8bit
(0-10Vcce)

Communications Duplex)-- SPI -- TTL RS485
TOTAL Input points 8
TOTAL Output points 8
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vcce) 7 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input eleid 7 to 24Vdc
I min: 2to 12 mA | min: 3/6 mA
HS Galvanic Isolation Se arated PCRB ground
(24Vcc) Rated Voltage: 24Vdc P 9
0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

PWM lIsolated Output
8hit (24vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM lIsolated
Output 8bit (24vcc)

Expandability

I2C — RS485( Half Duplex ) — SPI

~TTL

Reference

017001001200
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2. Technical Specifications

2.1  General Specifications:

Power supply

voltage DC power supply 12t024vdc ===
Operating
voltage range DC power supply 11.4t025.4vdc ===
e DC power supply 30VAC max.

consumption

External

Power supply voltage 24Vdc ===

power supply

Power supply output
capacity

700 mA

Insulation resistance

terminal.

20MQ min. at 500Vdc between the AC terminals and the protective ground

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
350g max.

Weight

2.2 Performance Specification:

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/lHomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM) 2.5KB
EEPROM 1KB
Clock Speed 16MHz

11




2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the Spartan Arduino PLC :

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : , :
—— Graphical symbols 5031 / Direct Indicates that the equipment IS
HE BN = for use on Current suitable for direct current only;
; to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
N for use on 5032 / Alternating only; to identify relevant
; Current .
equipment terminals
IEC 60417 /
hical I Toi ify th I
capnica s | sy puse | 1o ey e corte
; General '
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground . . ;
equipment 5019 is explicily required.
IEC 60417 / , . .
Graphical symbols To identify the swﬂch by
for use on 5115/ Slgnal lamp means of which the signal
) lamp(s) is (are) switched on or
equipment

off.

C€

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking applicable European Union
93/42/EEC regulations
ISO 7000/ , .
Graphical symbols Indlcates_a pc_)tentlal_ly :
for use on 0434B / hazardous situation which, if
equioment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Grap;(f;;ciesyggbols 5036 / Dangerous To indicate hazards arising
equipment Voltage from dangerous voltages

12




3. Precautions

Read this manual before attempting to use the Spartan Arduino PLC and follow its descriptions
for reference during operation.

3.1  Arduino Board

The Spartan Arduino PLC include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Spartan Arduino PLC according to the performance specifications
described in this manual.

Before using Spartan Arduino PLC under different conditions from what has been specified in
this manual or integrating Spartan Arduino PLC to nuclear control systems, railroad systems,
aviation systems, vehicles, combustion systems, medical equipment, amusement machines,
safety equipment and other systems, machines, and equipment that may have a serious
influence on lives and property if used improperly, consult your INDUSTRIAL SHIELDS
representative. Ensure that the rating and performance characteristics of Spartan Arduino PLC
are sufficient for the systems, machines, and equipment, and be sure to provide the systems,
machines, and equipment double safety mechanisms. This manual provides information for
programming and operating the Spartan Arduino PLC.

13



4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.
Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:
Arduino IDE 1.8.0 or above (better to have always the latest version).
Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings | Networl:

Sketrhbook location:

C:\Users\Albert\DocumentshArduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)

Editor font size: 15

Interface scale; Automatic | 100 3 %  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: None

[ bisplay line numbers

[Jenable code Folding

Verify code after upload

[Juse external editor

Check: for updates on startup

Update sketch files to new extension on save (.pde -> .ina)

Save when verifying or uploading

Additional Boards Manager URLs: |http://apps.industrialshields. com/main/arduina /boards/pack-age_industrialshields_inde: | [

More preferences can be edited directly in the file
C:\Users\Albert\AppDatalLocal\Arduino15\preferences. bt
(edit only when Arduing is not running)

oK Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

14



4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch_mar16a | Arduino 180

File Edit Skewh Tools Help

Auto Format Cul+T
Archive Sketch
Fix Encoding & Reload
Serial Monitor Cul+ShiftsM
Y senal Plotier Cul+Shiltsl

WAFi101 Firmware Updater
Board: "M-Duino family” 3 Boards Manager..

Inchustrial Shaelcls: “M-Dy Arduine AVR. Bo

Port Asduin Yiin
Get Board Info Arduino/Gensino Uno
Arduino Duemilanove or Diecimila

) Programmer. “Archino as ISP 3
Burn Bootloader

Arduino Nano

Asduino/Geneano Mega of Mega 2560
Asduino Mega ADK

Arduino Leonardo

Archino Leonardo ETH

Archuing/ Genuano Micro

Arduing Esplora

Archino Mini

Arduino Ethernet

Arduino Fio

Ascuino BT

LilyPad Arduno US8

LilyPad Archino

Asduing Pro or Pro Min

Arduing NG o older

Arduino Robat Control

Archiino Robot Motor

Arching Gemma

Adatruit Circuit Playground
Aschin Yiin Mini
Arduino Industrial 101
Linino One
Archuin Uno WiFi

Industrial Shielcs b
Ardbox family
* | M-Duino family

5. Search for industrialshields.

& Boards Manager

Type All ~ | |industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duina family.
Online help

More infg

Install

Close




6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

a

5 Boards Manager.

M5StaccFIRE

ArdD0x GPRS family

18 avcoax WiFi/RT family
M-Duino family
W-Dui

Also there are some examples of programming in File -> Examples -> Spartan Arduino PLC.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

16



5. How to connect PLC Arduino to PC
- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Spartan Arduino PLC

- Select correct port.

@ sketch_mar16a | Arduino 180 - o8 x
File Ecit Sketch Tools Help
Auto Format coleT
Aurchive Sketch
Fix Enoding & Reload
Serial Monitor ColsshiteaM
| senal Plotter Colsshittd

WIF101 Firmware Updater

Boardt “Ardbas family
Inchustrial Shields: “Ardbox Analag”

Port i Senaipors
GetBaard Info COM13 (Arching Leonarddo)

, Programmer:Archin as ISP
Bum Baotioarer

17



6. How to connect PLC to power supply
- Spartan Arduino PLC 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[——
u GND I

0]

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: S
s =y

-12vdc / 24vdc T Yo
2.5A g
-30W ...
e
Industrial Shields power supplies provide parallel %
operation, overvoltage protection, and overcurrent %
protection. There is a LED inductor for power status, z"“

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

18



7. Ardbox Analog I/0 pinout:

7.1  Zone Connections
LEFT ZONE
= £
28 a c
58 | ¢ s
o g 5 |5}
o B 5
<O < [y
A0.4% 3 Analog Out
A0.3! 5 Analog Out
A0.2* 6 Analog Out
AO0.1* 9 Analog Out
NC - Not Connected
NC - Not Connected
A0.0* 13 Analog Out
Q0.7 1 Digital Output
Q0.6 0 Digital Output
Q0.5 7 Digital Output
Q0.4 3 PWM/digital Output
Q0.3 5 PWM/digital Output
Q0.2 6 PWM/digital Output
Q0.1 9 PWM/digital Output
NC - Not Connected
NC - Not Connected
Q0.0 13 PWM/digital Output
GNDCOM - GND
24VCOM - Power Supply

il

LEFT ZONE

Switch config*
(see section 8 for Communications

configuration. Enabling Communications

disables some 1/0s)

Analog Outputs pins

Digital Outputs pins

Power supply connectors
(24vdc - GND)

19



RIGHT ZONE

s | £ |&2 _
58 | 2 |gg g
°5 2 |29 s
<O < < [
A+12 - - RS485(A)
B-12 - - RS485(B)
NC - - Not Connected
NC - - Not Connected
SCL-PIN3! 3 3 SCL(12C)
SDA-PIN2? 2 2 SDA(I2C)
NC - 4 Not Connected
NC - 8 Not Connected
5V - - 5Vout DC
RESET - - RESET
SCK - - SPI
MOSI - - SPI
MISO - - SPI
10.7 18 18 Analog/Digital Input
10.6 19 19 Analog/Digital Input
10.5 20 20 Analog/Digital Input
10.4 21 21 Analog/Digital Input
10.3 22 22 Analog/Digital Input
10.2 23 23 Analog/Digital Input
10.1 8 8 Analog/Digital Input
NC - - Not Connected
NC - - Not Connected
10.0* 2 2 Digital interrupt

! See section 8 to enable these connections

2 See section 9 to enable these connections

20



RIGHT ZONE .| ON = LEFT ZONE

= 5 SDA-]
. ) =2 |SCL-D3/004

Switch config* 1= Switch config*
(see section 8 for Communications . (see section 8 for Communications
configuration. Enabling Communications i configuration. Enabling Communications
disables some 1/0Os) ) o l disables some 1/0s)

i =2 N,

L-PIN

& DA-PIN;

Communications pins = i Communications pins

Digital/Analog Inputs 10 Digital/Analog Inputs

21



HS*: Hardware Serial
SS*: Software Serial

1 See section 8 to enable these connections
2 See section 9 to enable these connections

NOTE: These Pins are not connected.

DEFAULT SERIGRAPHY CORRECT SERIGRAPHY
2 _— SDA-PIN2 SDA-PIN2
SCLPING
$| spA-PiN2 NC NC
= NC NC NC
NG
=5 GND GND
5v

Www. ndus triolsnielas.com

Config switch * .
(see section 8 for communications Input / Output Power LED Arduino Reset

configuration) button

22




8. Switch configuration

8.1

LEFT ZONE.

Communications and inputs/outputs can not work simultaneously.

General Switches Configuration

LEFT ZONE
SWITCH OFF ON
RS-485 DE D19/10.8 | DE-RS485
D19/10.8 RS-485 DE | D19/10.8
RS-485 RE D18/10.9 | RE-RS485
D18/10.9 RE-RS485 | D18/10.9
SDA-D2/10.0* SDA-D2 10.0
SCL-D3/Q0.6* | SCL-D3 Q0.6

*12C switch serigraphy is turned around. It should be: (SDA-D2 , SCL-D3). RX-RS485 should be RE-RS485

6. Always at ON position.

5. Always at OFF position.

4. Always at ON position.

3. Always at OFF position.

QFF ON

RS-485 DE
D19/10.8
RS-485 RE
D18/10.9
SDA-D2/10.0
SCL-D3/Q0.6

OFF ON

2. SDA-D2/10.0 — Choosing between SDA (12C) / Pin2 and 10.0. If this switch is ON, the 10.0 input
will be enabled and the SDA / Pin3 will be disabled. If this switch is OFF, the SDA / Pin2 will be

now available and 10.0 disabled.

1. SCL-D3/Q0.6 — Choosing between SCL (12C) / Pin3 and QQ.6. If this switch is ON, the Q0.6

input will be enabled and the SCL / Pin3 will be disabled. If this switch is OFF, the SCL / Pin3 will
be now available and Q0.6 disabled.
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TOP ZONE

Note: Don’t change the switch position

4. Always in OFF position.
OFF O
3. Always in ON position.
10.3
RS485 2. Always in OFF position.
10.2 1. Always in ON position.
R5485

RIGHT ZONE SWITCH

In function of the switch position you can select for ON Digital Output and for OFF Analog
Output.

OFF ON 4. ON position — Half Duplex / OFF position Full Duplex
L 3. ON position — Q0.4 / OFF position A0.4
Q0.4 -A04
Q0.3 - A0.3 2. ON position — Q0.3 / OFF position A0.3
Q0.2-A0.2 1. ON position — Q0.2 / OFF position A0.2
Q0.1 - A0.1 4. ON position — Q0.1 / OFF position A0.1
NC
NG 3.NC
Q0.0 - AQ.O 2 NC
OFF ON
1. ON position — Q0.0 / OFF position A0.0

24



8.2 RS- 485 Switch configuration

TOP

ZONE configured as it is shown in the table.

RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE must be

MODE Although the switch serigraphy is only referenced to RS-485.

OFF

ON

e Having this setup, the 10.3 & 10.2 are disabled

LEFT ZONE

SWITCH

CONFIGURATION

MODE

ON

RS-485 LEFT ZONE: In order to enable the RS-485 communication
protocol it is necessary that the switches of the left zone are
configured as it is showed in the table.

The ones marked with “-“ mean that they don’t affect the RS-485

OFF

ON

OFF

communication protocol

8.3  12C Switch configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
Q0.8 RS-485 DE
RS485/RS232 HS D18/10.9
o) RS-485 RE
Q0.9 D19/10.8
SDA-D2/10.0 OFF
RS485/RS232 HS
()] SCL-D3/Q0.6 OFF

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0
and Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up

resistor (IS.ACI2C-4.7K) is required.
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9. Ardbox - Arduino I/0s 5V pins

The Ardbox has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL-Pin 3 3
SDA - Pin 2 2
MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The I2C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.1 Pin2/Pin3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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10. I/0 technical details

Digital Output Waveform

[N o —1
v

DIGITALOUT

DIGITAL OUT
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PWM Waveform

PWHM OUTPOUT

——

v

ANALDG OUT
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Analog/Digital Input Turn-on
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11. Typical Connections
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Ferrite KITA

@l ono vl POWER
2247 B oomaw
SHIELDED CABLE E%

SHIELDED CABLE 0-10v
S12/24V omc 0.7
GND
Ferrite KITA
@qﬂ ) POWER
1224V B DGTALANALOG IV

SHIELDED CABLE J Douatoad D0 MOUNO LAYOUT: \



Ref. 017001001200

o-10v

s, W

Ferrite KITA
'

<

6}

/4

0.7

POWER

Rev.0: 06-04-20

SHIELDED CABLE ) s e Foreg \

Ferrite KI

),
SHIELDEDCABLE{ e — \

SHIELDED CABLE

sn2av
GND

ALWAYS
CONNECTED
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SHIELDED CABLE

Ferrite KIT#

Rev.0: 06-04-20

2124V

SHIELDED CABLE

* Seo the switch
configutarion (ON)
e &
ALWAYS
n CONNECTED
Ferrte KITA @
GND -
‘E] I‘ VOUT =0/ Vde
SHIELDED CABL \
\/ J

SHIELDED CABLE
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Ferrite KI°

TA

Rev.0: 06-04-20

* See the switch
configutarion (OFF)

{n) v o-1ov)

\Z
SHIELDED CABLE
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12. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference  MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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13. Spartan Arduino PLC Dimensions:

45mm width

&

114

- DIN rail mounting:

Profilato o cappello TH 35-7,5 Prcfilato o coppello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 5
"
ak 1004
15°
. ROS
R12
e =03 R0
S
+
ISR 1004
A Sezione A/ Secton A k12
0.3 max - 2,2 min. finoa / To 2,5 max
3 -
< Sezone A/ Sedtion A
CARATTERISTICHE METODO  UNITA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Meccaniche li KT 0638  MPo 8 Mechanicol fest R ik ASTMDG638 MRy 8
Resi ongo s ASTIADE3B WP 8 Tnslestongth ASTHD63 MRy 8
Alrgamerto o totn KTM0638 % 59 Ut o ASTMDE38 % ]
Moduly in fesione KSTHDT0  MPo 2694 Pleing moduls ASTMDT0 MR yiiild
Provg lz0d con intoglo 15018014 Xy/ot 55 rod st otched 19018014 Xyin’ 55
Termiche Temp. di nmmollimento Vicot mekodo B ASTM 01525 °C 114 Thermal fest e metiodB  ASTMDIS2S °C 14
Tomperotum Riatio 1 81 MRy KTHDG8  °C 7 Rebeating temperctur 1,81 MPg ASTMDS4  °C 9
Fisiche Peso specio KA géamd 1 Physical test  Spacic gmuity ASTADTR2 _ géond 12
Riti nellostompo KTHD9SS % 0406 g shi ASTID9SS % 0406
Mk Flow Index 260°C- 98K KTADIZE g1l 11 ek Fiow index 260°C- 98K ASTHDIZE g1’ 1l
(Comportamento Aukesinguerzs (mm di pesor) o4 - V-0(08) Flame fest Saf atinguisher thideness in ) o4 - V-0(08)
ollo fiomma il Incondescen 32 mm 9521 °C 960 32 mm 169521 °C 960
Inaltronic si riserva il diiflo di modificore il moteriole con cui realizza i propri prodotti Itolonic con opercte any change of the moteriols without being obliged to forewam.
senzo obbligo di preawiiso.
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14.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/0O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the Spartan Arduino PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
Spartan Arduino PLC. When configuring the layout of the Spartan Arduino PLC inside your
panel, consider the heat-generating devices and locate the electronic-type devices in the
cooler areas of your cabinet. Reducing the exposure to a high-temperature environment
will extend the operating life of any electronic device. Consider also the routing of the
wiring for the devices in the electric cabinet. Avoid placing low-voltage signal wires and
communications cables in the same tray with AC power wiring and high energy, rapidly-
switched DC wiring.
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Provide adequate clearance for cooling and wiring Spartan Arduino PLC. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm above
and below the devices. Also, allow at least 25 cm of depth between the front of the modules
and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debrisin a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

37



- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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